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CLARIS™ Software License

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE OPENING THE
PACKAGE CONTAINING THE SOFTWARE. BY OPENING SUCH PACKAGE,
YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS LICENSE. IF
YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE
THE SOFTWARE AND PROMPTLY RETURN THE PACKAGE TO THE PLACE
WHERE YOU OBTAINED IT.

The accompanying computer program MacPaint Demo (“Software”) is licensed,
not sold, to you by Claris for use only under the terms of this License, and Claris
reserves any rights not expressly granted to you. You own the disk on which
any Software is recorded or fixed, but Claris retains ownership of all copies of
the Software itself. |

1. License. This License allows you to use the Software only on a single
computer at a time, except that the Software may be executed from a common
disk shared by multiple CPUs provided that one authorized copy of the
Software has been licensed from Claris for each CPU executing the Software.
Claris does not, however, guarantee that the Software will function properly in
your multi-user environment.

2. Restrictions. You may NOT distribute copies of the Software to others or
electronically transfer the Software from one computer to another over a
network. The Software contains trade secrets and to protect them you may
NOT decompile, reverse engineer, disassemble, or otherwise reduce the
Software to a human perceivable form. YOU MAY NOT MODIFY, ADAPT,
TRANSLATE, RENT, LEASE, LOAN, RESELL FOR PROFIT, DISTRIBUTE,
NETWORK, OR CREATE DERIVATIVE WORKS BASED UPON THE
SOFTWARE OR ANY PART THEREOF.

3. Termination. This License is effective until terminated. This License will
terminate immediately without notice from Claris if you fail to comply with any
provision of this License. Upon termination you must destroy the Software and
all copies thereof. You may terminate this License at any time by destroying the
Software and all copies thereof.

4. Export Law Assurances. You agree that neither the Software nor any direct
product thereof is being or will be shipped, transferred or reexported, directly
or indirectly, into any country prohibited by the United States Export
Administration Act and the regulations thereunder or will be used for any
purpose prohibited by the Act.

5. Warranty Disclaimer, Limitation of Remedies and Damages.

(a) Disclaimer of Warranty on Software. THE SOFTWARE IS PROVIDED “AS
IS* WITHOUT WARRANTY OF ANY KIND, AND CLARIS EXPRESSLY
DISCLAIMS ALL IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. CLARIS DOES NOT WARRANT, GUARANTEE, OR
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS
OF THE USE OF THE SOFTWARE OR ANY ACCOMPANYING WRITTEN
MATERIALS IN TERMS OF THEIR CORRECTNESS, ACCURACY,
RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO
THE RESULTS AND PERFORMANCE OF THE SOFTWARE AND WRITTEN
MATERIALS IS ASSUMED BY YOU. CLARIS DOES NOT WARRANT THAT
THE SOFTWARE WILL WORK CORRECTLY IN YOUR MULTI-USER
ENVIRONMENT. IF THE SOFTWARE IS DEFECTIVE, YOU, AND NOT CLARIS
OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR

CORRECTION. SOME STATES DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO
YOU.

(b) Complete Statement of Warranty. THE LIMITED WARRANTIES
PROVIDED IN SUBPARAGRAPH (a) ABOVE ARE THE ONLY WARRANTIES
OF ANY KIND THAT ARE MADE BY CLARIS ON THIS CLARIS PRODUCT. NO
ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY CLARIS, ITS
DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES SHALL CREATE A
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY,
AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. THIS
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE
OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.

(c) Limitation of Liability. IN NO EVENT WILL CLARIS, OR ITS
DEVELOPERS, DIRECTORS, OFFICERS, EMPLOYEES, OR AFFILIATES BE
LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT
DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE
LIKE) ARISING QUT OF THE USE OR OR INABILITY TO USE THE
SOFTWARE OR ACCOMPANYING WRITTEN MATERIALS EVEN IF CLARIS
OR AN AUTHORIZED CLARIS REPRESENTATIVE HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.

BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL
DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. Claris'
liability to you for actual damages for any caused whatsoever, and regardless
of the form of the action, will be limited to the greater of $500 or the money
paid for the Software that caused the damages.

6. General. If you are a U. S. Government end-user, this license of the
Software conveys only “RESTRICTED RIGHTS", and its use, disclosure and
duplication are subject to Federal Acquisition Regulations, 52.227-7013(c)(1)
(ii). This license will be construed under the laws of the state of California,
except for that body of law dealing with conflicts of law. If any provision of this
License shall be held by a court of competent jurisdiction to be contrary to law,
that provision will be enforced to the maximum extent permissible, and the
remaining provisions of this License will remain in full force and effect.

Apple ™ Computer Notices

APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESS OR
IMPLIED, REGARDING THE ENCLOSED COMPUTER SOFTWARE
PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS
NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT
APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL
RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH
VARY FROM STATE TO STATE.

The Font/DA Mover is a copyrighted program of Apple Computer, Inc. licensed
to W. H. Freeman and Company to distribute for use only in combination with

Letterforms & llusion. Apple Software shall not be copied onto another diskette
(except for archive purposes) or into memory unless as part of the execution of

Letterforms & fllusion. When Letterforms & Hllusion has completed execution
Annle Saftwarae chall not he 1ead hw anv other oroaram.
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Preface

Bernard DeKoven

What do you get when you combine computer science with
calligraphy, mathematics, and a penchant for puzzles?

You get an opportunity to play your way to a new level of
sensitivity and understanding: sensitivity to the beauty of
the written word and understanding of the mathematics of
its design.

Letterforms & Illusion is a collection of perceptual puzzles
that will challenge and ultimately change your perception
of the nature and functions of the alphabet. By toying
with each of the many delightful puzzles and activities,
you will be taking a computer-enhanced journey into a
Wonderland of typography.

Until the publication of this work, this particular
Wonderland could only be visited by those who had the
practiced hand of a scribe and the conceptual mastery of a
font designer. Assisted by the magic of the Macintosh,
you now need only a good eye and a sharp mind for your
journey.

You begin by playing. Turn on your computer, put in the
disk, open the book, and hold on to your mouse.

The first plaything you will encounter will be the software
program that sold the Macintosh into the hearts and
homes of America: MacPaint. If you have never seen or
used this program before, you will learn how to use it
without even trying. The activities in the disk are carefully

sequenced so that each new puzzle builds on the
knowledge you gained solving the previous puzzles. As
you progress through the sequence, you will also gain the
mechanical knowledge needed to understand MacPaint
and the conceptual knowledge that is key to
understanding the principles of graphic design. If you are
already familiar with this software, prepare to experience
it in a very new light. The Letterforms desk accessory,
called Flips, acts as a special interface to MacPaint,
transforming MacPaint to what might be called
“MacPuzzler.” What was once a simple but powerful
graphics program now also becomes a new medium for
interactive puzzles and exercises in creative play.

Some of the puzzles in this collection are extremely
challenging. Others are simply surprises: opportunities to
share the author's delight in and fascination with the play
between the forms and meanings of writing. There are
dozens of different kinds of puzzles, each one serving as a
template for the creation of whole collections of uniquely
challenging, educational, sensitizing exercises in reason
and design.

If you happen to be a teacher or a parent, you'll find that
many of the properties that make this publication
enjoyable for you also make it educational for your
children. The ease of learning, the playful invitation to
explore the elements of design, and the re-visioning of the
shape and functions of letters all contribute to making
this a truly educational product. As supplementary



activities, the puzzles are as well suited to the
mathematics curriculum as they are to language and
creative arts. Children will find endless delight in using
the collection of special fonts to make more puzzles and
designs or to compose secret messages.

There's a lot to play with here, a lot of new visions and
ideas. So take your time, enjoy. If you can't solve a
puzzle, see what else you can do with it. After all, you're
working on probably the most player-friendly business
computer ever made. Take advantage of the interactivity.
Whatever you do you can undo. If you can't solve
something immediately, chances are that you will discover
the solution simply by toying with the pieces. Copy
things, move things, flip things around. Maybe you'll make
up a new puzzle or an eye-and-mind-catching design or a
new font or discover a new form of calligraphy. Whatever
happens, merely by playing you will acquire a deeper
appreciation and perhaps a new love for the design and
delight of letters. You will also have a lot of fun.



Introduction

Scott Kim

In 1981 I wrote the book Inversions. Inversions are words
written so they can be read in more than one way. Here is
an inversion on mac that reads the same upside down:

IVAC

In 1984, Robin Fe Samelson suggested we write software
based on Inversions. Robin wanted to learn how inversions
work; | wanted to explore the Macintosh computer as a
medium for creating interactive books. Surely we could do
something interesting together. But what?

Could we write a program to automatically invent
inversions on any word it was given? An intriguing idea,
but getting a computer to understand the subtleties of
letterform design would be far too hard. Besides,
automating the process would take the fun out of it. What
about a disk of designs from the book? Too passive. How
about fonts based on lettering styles in Inversions? Good
idea, but fonts by themselves would not offer enough
focus.

We decided to create a disk of puzzles based on original
fonts. We built our puzzles in MacPaint, which had
everything we needed for flipping and manipulating
letterforms. MacPaint was a bit cumbersome for some of
our needs, so we added a new Flips menu to MacPaint
with shortcuts for frequently used commands.

Most people know MacPaint as an entertaining,
easy-to-use program for doodling. But it is much deeper.

When I first tried MacPaint in 1984, I timidly poked at all
the tools to see what they did. | stopped once I had filled
the screen with squiggles, satisfied that I had seen all
there was to see. But hiding in the keyboard were special
keys that would turn MacPaint into a powerful tool for
rapidly transforming images. In Letterforms & Illusion, you
will learn some of these advanced techniques.

Inversions are no strangers to computers. About a third of
the images in Inversions were originally drawn with
computer programs | wrote at the Xerox Palo Alto
Research Center with help from John Warnock, the
creator of PostScript. The programs were written in John's
programming language JaM, the precursor to PostScript.
To program the images, | had to assemble them first in my
mind's eye. In the Kits section of Letterforms & Illusion.,
you can experience some of the visualization challenges I
faced.

Some of the fonts in Letterforms & Illusion were adapted
from particular designs from Inversions, such as Infinity
and Escher. Other fonts were created specifically for play
on the screen, such as Flipfont and [llusion. We have

invented puzzles to show some of the ways you can play
with the fonts.

Now it is your turn to explore. What games can you
discover that we never dreamed of?



Robin Fe Samelson

If it weren't for flowers there wouldn’t be bees and if it
weren't for bees there wouldn't be flowers. Isn’t there some
way of expressing the relationship between flowers and
bees in a single word?

[ was struck by this question in a lecture given by a
visiting biology professor from Sonoma State University
while | was taking classes in botanical medicine at a
nearby school. As I listened, a form began taking shape in
my mind. In a few minutes, out came the flower/bee

design:
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[ showed it to the lecturer after class. “This is a way to
express the infinite loop in that idea,” I thought. I gave
him the design. He smiled and thanked me.

I like explaining things. When | met Scott, I became
interested in explaining how to do inversions in a way that
would invite others to participate in the process. First I
identified the types of thinking that go into making
inversions. Then Scott and I developed games around each
type of thinking.

For example, we are all taught to make letters according to
strict rules about what a “proper” letter looks like. But the
letters that make up inversions are hardly proper. How
can you learn to stretch your idea of what a letter can look
like? One way is to play with parts of letters instead of
whole letters. Hence, Scott developed the font called Parts.

Parts lets you see letters in a new light. Instead of vowels
and consonants, you learn to see straight lines and curved
lines.

The puzzles and fonts in Letterforms are designed to be fun
and to encourage your creativity. They may even give you

a new way of expressing yourself, as they did for me with
the flower /bee design. My playing has led me to collecting
pictures made from the fonts for a book of font art. If you
would like information on how to submit pictures for the
font art book, our address is Look Twice, P.O. Box 50697,
Palo Alto, CA 94303.

Acknowledgments

Many people helped us shape this product. Their
contributions ranged from creating the opportunity to
begin, visualizing what was possible, and providing ideas
for the product, to supporting our practical needs,
trimming the superfluous, and helping get things done.
They include Ed Kelly, Douglas McKenna, Douglas
Hofstadter, Lucia Grossberger, Ann McCormick, Amanda
Ropa, Jef Raskin, Michael Waitsman, Scot Morris, Michael
Arent, Bonnie Baker, Don Link, Chuck Blanchard, David
Oster, Softweaver (Howard Pearlmutter, Leland Wallace,
Ted Tripp), Bobbie Fishman, Vince Dorn, and Claris Corp.

We wish to thank Jeremiah Lyons of W. H. Freeman and
Company for choosing to produce and market Letterforms
& IMllusion, and we thank Dorothy Spencer and Larry Cuba
for acting as our agents and packaging the final form.

In the beginning, David Thornburg laid the foundation in
his ever creative style. In the final stages of development,
Bernard DeKoven was invaluable in providing coherence
and play value to the puzzles.



Software Overview

Start
here
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1. Introduction is the first of
62 MacPaint files on the disk.
Begin by opening this file, which
will start up MacPaint. The
instructions on the screen will
tell you what to do next. See

Getting Started (page 10 in this
booklet) for assistance,

Tutorial teaches you everything
you need to know about MacPaint
to play with the puzzles and kits.
Please read the Tutorial even if you
are familiar with MacPaint.

Tutorial Introduction
Lasso, Marquee
Flipping

Copying

Undo

Grid, Grabber

NORsLN

MacPaint Demo is a special version of MacPaint 2.0 for use with the
Letterforms software. If you already own a paint program, you may want to
use it instead of MacPaint Demo. See Installing the Paint Program (page 12

of this booklet).

Letterforms fonts. Ten fonts (Blend,
Boxes, Close-up, Edmond, Escher,
Flipfont, [llusion, Infinity, Parts,
Tessellation) for solving puzzles or

making designs. See pages 16-36 of this

booklet for information on each font.

Flips DA. A desk accessory that
adds a menu called Flips to
MacPaint. See Flip Puzzles [page
14 of this booklet) for more
information on the Flips menu.

Flips contains puzzles that
challenge you to complete designs
by flipping letters. See Flips (page 14
of this booklet) for more
information. Answers to all puzzles
are on pages 40-46 of this booklet.

8. Flips Introduction

9. Key Commands

10. Inversions

11. Flip Horizontal, Vertical
12. Rotate Left, Right

13. Flipabet

14. Halphabet

15. Numbers

16. Flip Pairs

Aj

Font/DA Mover. If you want to
use the Letterforms software with
a paint program other than
MacPaint Demo, you will need to
use the Font/DA Mover to move
the Letterforms Fonts and Flips
DA from MacPaint Demo to your
system. See Installing the Paint
Program (page 12 of this booklet)
for details.

. R Y e T S P
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The Letterforms & Illusion disk contains
— 62 MacPaint files
— 10 fonts
— Flips desk accessory
— MacPaint Demo
— Font/DA Mover

i1s & Illusion

Fonts contains games and puzzles E

based on the Letterforms fonts. The

lllusion and Flipfont games introduce Kits are collections of letter parts for

ways to play with fonts. The building designs from Inversions. See

Close-up, Parts, Blend, and Boxes pages 38-39 of this booklet for

puzzles invite you to see the shapes completed designs.

in letters. The Tessellation, Escher, 49. Kits Introduction 56. Escher

and Infinity puzzles challenge you to 50. Upside Down 57. Synergy 62. The End. When you are
weave designs out of letters. See 51. Einstein 58. Infinity done with this disk, you can
pages 16-36 of this booklet for 52. Mozart 59. Pilobolus go on to create your own
details on each font. Answers to 53. Gutenberg 60. Figure puzzles and designs. See
puzzles are on pages 40-46. 54. Mirror 61. Tree Making Your Own Puzzles

17. Fonts Introduction 55. Problem (page 37 of this booklet) for
o tips.

IMlusion Parts Tessellation

18. [usion Introduction 25. Parts Introduction 35. Tessellation Introduction

19. MNlusion Stretch 26. Parts Upper, Lower 36. Tessellation Jams

20. Ilusion Examples 27. Parts Straight, Curved 37. Tessellation Negative

38. Tessellations 1
39. Tessellations 2

Flipfont Blend D Escher
21. Flipfont Intreduction 28. Blend Introduction 40. Escher Introduction
22. Flipfont Typing 29. Blend Positive 41. Escher Crosswords 1
30. Blend Negative 42. Escher Crosswords 2
31. Blend Mixed 43. Escher Pinwheels
44. Escher Patterns
Close-up Boxes t Infinity
23. Close-up Introduction 32. Boxes Introduction 45. Infinity Introduction
24, Close-up Match 33. Boxes Languages 46. Infinity Flipping
34. Boxes Sayings 47. Infinity Typing

48. Infinity Modifying




Getting Started

Step 1. You Will Need

Macintosh. Letterforms & Illusion works with all Apple
Macintosh computers. An external disk drive or hard disk
drive is helpful but not necessary.

Macintosh experience. We assume you are already
familiar with the basics of using your Macintosh. If you
need assistance, please consult your Macintosh Owner’s
Guide. MacPaint experience is helpful but not necessary.

Working copy. Make a working copy of the Letterforms &
Illusion disk by copying the entire contents of the disk
onto a blank disk or into a folder on your hard disk. Keep
the original disk as a backup copy and use only the
working copy. By keeping a backup copy, you will always
have an untouched version of the original software.

Inversions (optional). This software is based on the book
Inversions by Scott Kim. If you have a copy, keep it handy
for reference. You do not need the book to use the
software. For information on Inversions, see page 47.

10

Step 2. Preparing to Use MacPaint

To use the software, you will need to use a paint

program. Letterforms & Illusion comes with a special
version of MacPaint 2.0, called MacPaint Demo, courtesy of
Claris Corporation. For most purposes, this paint program
is entirely adequate for use with the Letterforms software.

In the following cases, however, you may prefer to use
your own painting program instead of MacPaint Demo.

— If you own a Macintosh 128K or 512K you will not
be able to use MacPaint Demo. In this case you must
use your own copy of MacPaint (version 1.5 or earlier),
which was included when you bought your computer.,

— If you already own MacPaint you may want to use your
paint program instead of ours, since our MacPaint
cannot save or print files. Except for saving and
printing, MacPaint Demo is exactly the same as
MacPaint 2.0.

To use Letterforms & [llusion with MacPaint Demo no
special preparation is necessary and you may go on to
Step 3. To use Letterforms & Illusion with a paint program
other than MacPaint Demo you must first install the other

paint program. See Installing the Paint Program (page 12
of this booklet) for instructions.



Step 3. Opening MacPaint

— Turn on the Macintosh. If you have copied the
Letterforms software onto a hard disk, open the
Letterforms folder. If you are not using a hard disk,
insert a system disk into a drive, then insert your
working copy of the Letterforms disk into a drive.

— After a few moments you will see this window:
SO Letterforms O Illusion S|

B items TEIE in disk 13K available

K7

F o

FLIP PUZZLES FONT PUZZLES

EITS @

62. The End

@ TUTOR AL

1. vt odhuntion

@ @

MacF ant® Demo Font /D& Mover -
o
& o)

— Open “Introduction” by double-clicking its icon. In a
moment MacPaint will start up and you will see:

O esssmmmm * 1. Introduction” ot 1007, e8|

e
Lusion

Welcome to Lettsrforms & [llusion, a disk of MacPaint puzzles.
Here i3 a puzzle to try right now: lasso () illusion and move it
straight up to complete the word LETTERFORMS. (If you do not
kniow how to lasso, keep reading and you will learn in a moment.)

To go on, choose Flips from the & menu. Then choose Next File
from the Flips menu. If MacPaint asks you "Save changes.. before
closing?” click on (Mo ). For help, see page 11 of your booklet.

— You are ready to play. Follow the instructions on the
screen to go from puzzle to puzzle. Refer to this booklet
for more information on particular puzzles and fonts.
Answers are at the back of this booklet. Have fun!

Tips for Using the Software

Starting over. To start a puzzle over, choose Revert from
the Edit menu to restore the file to its original form.

Flipping. Before you flip or rotate an image, first select it
with the marquee. Some flip commands cause the image
to flip several times before reaching the correct position.

Grid. Keep Grid (in the Goodies menu) turned on to make
it easy to select images with the marquee. Turn Grid off if
you want to move an image a small distance. If Grid fails
to work properly, try turning it off and back on.

Flips menu. If Flips is not in the ¢ menu, you need to
move the Flips desk accessory (DA) to your system by
using the Font/DA Mover. See Installing the Paint
Program (page 12 of this booklet) for instructions. Without
Flips, the key commands for opening files and for flipping
images will not work, nor will the Blend font look right.

Typing. If the letters you type look wrong on the screen
you may have changed the font style inadvertently. To
reset the style, choose Plain, 12 point, and Align Left from
the Style menu.

Printing and saving files from MacPaint Demo.
MacPaint Demo will not let you save or print files. To save
or print an image, use the Scrapbook to transfer the image
to another program: Select the image, choose Copy from
the Edit menu, choose the Scrapbook from the menu,
and choose Paste from the Edit menu. Quit MacPaint and
open another paint program, word processor, or other
application that allows you to paste images. Choose the
Scrapbook from the menu, choose Copy from the Edit
menu, close the Scrapbook, and choose Paste from the
Edit menu. Then choose Save or Print from the File menu.
If you frequently want to save or print images, you will
find it more convenient to use your own paint program.

See page 12 of this booklet for details. 19



Installing the Paint Program

Step 1. Preparing the Disks Step 2. Moving the Fonts to Your System

Read these two pages only if you want to use Letterforms
& Ilusion with a paint program other than MacPaint Demo
(which is included on the Letterforms disk).

Next, you will copy the Letterforms fonts and desk
accessory from MacPaint Demo to your system disk, by
using an application called the Font/DA Mover.

— If your computer is a Macintosh Plus, SE, I, or other
recent model, you may skip this step and go on to
Step 2. If your computer is not one of these models but
has an 800K disk drive, go on to Step 2.

— Turn on your Macintosh. Insert a system disk. Insert
the Letterforms & Illusion disk (or Letterforms Part 1).
Open the Font/DA Mover on the Letterforms disk. You
will see a window with two fields. The left field lists
fonts in your system:

— If your computer is a Macintosh 128 or 512 without
an external 800K disk drive, then your Macintosh
can only read single-sided (400K) disks. Letterforms &

@® Font

O Desk Accessory | over

[llusion comes on a double-sided (800K) disk. You need E::::::;? &
to copy the Letterforms software onto 400K disks Sondea 18
before you can use it. Please read on. Geneva 12
Geneva 14
— To copy the software onto 400K disks, you will need :::::: ;: 3
three blank disks, your own copy of MacPaint (version System ; |
1.5 or earlier), a system disk (any disk that includes a O e | el J |
System Folder) and a Macintosh with an 800K drive. ([ Clese | ! [ ouit . ([ open... )

— Turn on your Macintosh. Insert each blank disk in the

800K drive and initialize it as single-sided. (An 800K — Prss afid hald the Option Wi s Wtle olding it.

- Chicago 12 fopy | [Blend 12
label it Letterforms Part 2. Do not copy MacPaint Demo. e Ssios 13
Geneva 10 kemoue | [Closelp 12
— Copy the System Folder from one of your disks and Geneva 12 Escher 9
Geneva 14 Escher 10
your copy of MacPaint (version 1.5 or earlier) onto the ks 18 il
third disk, and label it Letterforms System Disk. Please Geneva 20 Flipfont 10

12

drive can initialize both 400K and 800K disks.)

Copy 1. Open Me First, Tutorial, Flips and Fonts from
the Letterforms & [llusion disk onto the first disk, and
label it Letterforms Part 1.

Copy Kits, 62. The End and Font/DA Mover from the
Letterforms & Illusion disk onto the second disk, and

use this system disk throughout Steps 2, 3, and 4.

click on the Open button beneath the right field. Keep
holding the Option key until the dialog box for opening
a file appears, then release the Option key. Select
MacPaint Demo and click on the Open button. You will
see a list of the Letterforms fonts in the right field:

® Font

() Desk Accessory e

MacPaint® Demo
] onLetterforms & ...
13K free

[ uit ] | | [ FIII! ]

System
on Your System Disk [ Help
“ 671K free |

[  Close |




— Select the entire list of Letterforms fonts by moving the

cursor to the first font name (Blend), pressing and
holding the mouse button, and dragging down past the
bottom of the list. The field will automatically scroll up,
selecting all fonts (ending with Tessellation):

® Font

() Desk Accessory Meoer

Chicago 12
Geneva 9 srts 9
| |Geneva 10 T
Geneva 12
Geneva 14
Geneva 18
Geneva 20
System :

on Your System Disk |  Help | lon Letterforms & ...
671K free | 13K free

[ s | | owit'™]| Close |

|
arts 12

I

]

Click on the Copy button to copy all the fonts from
MacPaint Demo into your system.

You need at least BOK of space available on your
system disk to hold the fonts. If there is not enough
space, you need to make more space by throwing away
unnecessary files from the System Folder on your
system disk to make more space. The only files you
must keep are System and Finder (and, to print,
ImageWriter, or LaserWrite and LaserWriter Prep). For

safety, be sure to make a copy of your system disk
before removing any files.

If there is still not enough space, use the Font/DA
Mover to remove extra fonts and desk accessories from
your system. Open the Font/DA Mover, select fonts
you want to remove, and click on the Remove button.
(The Font/DA Mover will not let you remove system
fonts Chicago 12, Geneva 9, Geneva 12, or Monaco 9.)
Then copy the Letterforms fonts to your system disk.

Step 3. Moving the Desk Accessory to Your System

— With the Font/DA Mover open, click on the Desk

Accessory button at the top of the window. You will see
desk accessories in your system listed in the left field.

— Press and hold the Option key, and while holding it,

click on the Open button beneath the right field. Select
MacPaint Demo and click on the Open button. You will
see Flips in the right window:

) Font
® Desk Accessory Movse
Alarm Clock Ko Copy ] [Flips 3
Calculator
Chooser | Remoue | k
Control Panel
Find File
Key Caps
Scrapbook Ty o
System : MacPaint® Demo
on Look Twice |  Help | onletterforms & ...
991K free 13K free

(e ") |0 Sd " 1 [ Sewe ]

— Select Flips and click on the Copy button. If there is

not at least 19K of space available, make more space
on your system disk before copying Flips. Click on the
Quit button to quit the Font/DA Mover.

Step 4. Opening the Paint Program

— Start up your Macintosh with the newly modified

system disk. Insert the disk containing the paint
program you want to use. Open the paint program by
double-clicking its icon. Check the Font menu for the
Letterforms fonts, and the # menu for Flips. If they are
not there, try Steps 2 and 3 again.

Open 1. Introduction from the Letterforms disk. Follow
the instructions on the screen to go from puzzle to
puzzle. Whenever MacPaint asks you "Save changes
belore closing?” respond by clicking on the No button,

so the files on the disk remain unchanged. 13



Flips

About Flips

Flips is a folder on the disk. It contains puzzles that
challenge you to flip shapes in your imagination. Before
you try the Flips puzzles, please read through the files in
the Tutorial folder, which explain everything you need to
know about MacPaint to use the puzzles.

To solve the Flips puzzles you will use a special menu
called Flips, which comes with Letterforms & Illusion. The
Flips menu adds new commands to MacPaint that make it
easy for you to open files or flip shapes quickly.

About the Flips Menu

To add the Flips menu to the ﬂ
MacPaint menu bar, open MacPaint
and choose Flips from the & menu.

Alarm Clock

P et Calculator
(If you do not see Flips 51: ;‘T e Chooser
¢ menu, you must move the Flips Control Panel

DA to your system. See Installing
the Paint Program on page 12 of
this booklet for instructions.) The
Flips menu will appear at the right
end of the MacPaint menu bar.

Find File

Key Caps
Scrapbook

By the way, you can use Flips with any MacPaint file, not
just the ones in Letterforms & Illusion. Just be sure to add
the Flips menu to the MacPaint menu bar before using it.
The Next File command opens whatever MacPaint files
you have on your disk in alphabetical order.

14

Key Commands

Most of the commands in the Flips menu have equivalent
key commands which you can type from the keyboard.
Key commands are listed in the Flips menu to the right of
the command names. For instance, the key command for
Next File is 8N. To use it, press and hold the Command
key (3), and while holding it, type the letter N.

Key commands in the Flips menu override key commands
with the same names in the regular MacPaint menus. You
can still use the MacPaint commands by choosing them
from menus instead of typing key commands.

Key
commands

Next File 3N overrides New in File menu
Previous File ®P overrides Plain in Style menu
Open File... #0 overrides Open... in File menu

++| Flip Horizontal €1
1] Flip Dertical %2
Rotate Left 90° %3
Rotate Right 90° %4 | — override commands in Goodies
G ) Rotate 180° *5 menu for switching
windows

Smaller Font Size 3«
Larger Font Size 3&
About Flips...

Quit Flips




Flips are Visual Thinking

If you have ever solved a puzzle strictly in your head you
may have already mastered some of the flips you will find
in the Flips. We use the word flips to describe all seven

symmetry operations in the Flips menu. The picture below
illustrates the different operations.

Spatial transformations, mental rotation, visual thinking
skills, and puzzles in your head are some of the ways
people describe the puzzles you will see in the software.
The puzzles challenge your skill to do such things as Flip
Horizontal, Flip Vertical, Rotate Left, Rotate Right, Flip
Left Diagonal, and Flip Right Diagonal. The Flips menu
includes these flips, each with its own key command.

(]

FLIPS

Invitation to a Challenge

As you go through the puzzles, see if you can imagine the
outcome of each flip before you see it. You will find that
your ability to visualize flips will improve as you work your
way through the disk.

word eye

Can you imagine, for example, what this design would
look like if you held it up to a mirror? You may find it
helpful to gesture the flips with your hands.

\

*®1 ¥*2 #®3 LR
Flip Horizontal Flip Uertical Rotate Left Rotate Right

15



Fonts

Fonts as Puzzles

Have you ever used a font to solve a puzzle? The
Letterforms disk contains ten fonts designed especially for
solving puzzles and making designs.

E] E m E ’:E’qul?n:t
S lifusion

Sk JUELF mﬁnu‘ Yy
Edmond Y Vouls 5
eESCHER

a* s

tessellation

The Fonts folder on the disk contains puzzles based on the
fonts. Each font has its own folder of puzzles, except for
Edmond, which has no puzzles.

The first puzzle of each folder invites you to type your
name and try experiments that demonstrate special

features of the font. The subsequent puzzles challenge you
to solve puzzles with the font.

Some of the fonts are highly symmetrical. Others create
interesting visual illusions. Escher has letters that can
rotate and be read as other letters. You can even type
inversions using the Infinity font. See the following pages
of this booklet for examples of designs you can make with
each font

16

Fonts as Design Elements

Besides solving puzzles with the fonts, you can make
designs. MacPaint gives you many tools for modifying
letterforms, such as Fat Bits, Invert, and Trace Edges. See
your MacPaint manual for tips on using the tools.

The Close-up font is an especially interesting starting
point for making designs. Can you see which part of the
name Robin was stacked in the picture below? You can see
other examples of font designs in the following pages.

I
S = 1N

E i“lllll“ ----- ““l‘




Font Characteristics

The Letterforms fonts have a few unusual characteristics
that are important for you to know about.

— The font size listed in the Style menu does not reflect
the actual size of the font on the screen. If you type a
word in “12-point” Edmond and change the font to
Hlusion you will see that "12-point” Illusion is gigantic
while “12-point” Edmond is tiny. Properly, 12-point
llusion should be listed as a 72-point font. But if fonts
were labeled according to their true sizes you would
have to keep changing font sizes as you changed fonts.
To minimize font size changes, we list the basic version
of every font as 12 point.

— Changing font size in the Style menu will not always
change the size of the letters. Sometimes changing font
size will give you another variation of the font with
letters of the same size. For instance, “14-point”
Edmond is a bold version of *12-point” Edmond, while
“10-point” Parts is the upper half of "12-point” Parts.

— Most of the Letterforms fonts take advantage of
MacPaint's Grid feature. For instance, Close-up letters
match the grid spacing in both height and width. Keep
Grid turned on to make letters easier to copy and {lip.
Turn Grid off when you want finer control.

— The Letterforms fonts are bitmapped fonts designed for
display on the screen or for printing on the
ImageWriter. You can print them on the LaserWriter,
but they will look jagged. For best results on the
LaserWriter, type your message in a paint program.
Then print the message directly from the paint

program, or copy the message and paste it into another

program such as a word processor. Using the fonts
directly in your word processor will give strange
results.

.0

FONTS

An Infinite Number of Puzzles

Most puzzles present challenges that you solve once then
put aside. This is not the case with the Letterforms
puzzles. Once you have solved a puzzle, you can make a
new one by using the font to fill in new pieces.

Make each nt' thau damgn: h}r t}rpmg juat two lettcrs Do not hnld tha
| Shift key. Use the Spacebar to advance, and the Delete key to erase. |

 VOXIMHAKWEER

TYPE
i
HERE

ABCDEFGHI JKLM
NOPQRSTUVWXYZ

Answers: pil]l"lE T‘ﬁ! Hanrntutﬁh.-

ey L LT

In the Blend puzzle above, for instance, you can type two
new letters in the Blend font and create a new form to
decipher. Since you have the whole alphabet to choose
from, there are many possible combinations.

You can do many creative things with the fonts in
Letterforms. We hope you do go on to create your own
puzzles. We would love to see your puzzles and designs.
You can write to us at Look Twice, P.O. Box 50697, Palo
Alto, CA 94303.

17



[|usion

[llusion can perform many tricks. The font is based on a T

pattern of evenly spaced black and white stripes. m
12 point

Every stripe, white or black, is exactly four pixels (screen

dots) wide. This means all strokes will match when you "I] [SI” U w H z
can splice the top half of one word onto the bottom half of
ﬂ % L

Characteristics

s i sl ol
~ MOPORSTUULAL2
lal 8 5 +{"~"
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© — e
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—
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ILLUSION

Using Illusion

ettt sy oo~ BAMMGUARE: JEANQUCAR:

slice words are about a quarter of the way from the top
and bottom.

Here's an unusual optical effect. Turn off Grid, select a P F
slice of the word, shift it four pixels left or right, and |
Invert.

] ]
To stretch a word, turn off Grid, select a slice of the word, Il | I "II I
hold the Shift, Option, and Command keys with one hand,
and drag the slice straight down with the other hand. This
will smear the edge of the slice like dragging a comb
through sand. Drag slowly so the stretch will be smooth. "
What other tricks can you invent?
[llusion can get you started making inversions. Copy the

top of a word, flip it, and join it to itself. You will rarely get  .-.-.-.... = seccoccenonn
a perfect inversion, but you will often come close enough ' & : : : :
to suggest how an inversion might be completed. : IImJ } [l"l 'nﬂn{U' ) I-l.Pll'.Ju

Tl o
EB‘)J ATCreeeree
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Alipfont

Flipfont is more fun to use than to read about. Try it! Set
up Flipfont and ask an unsuspecting friend to type
something while watching the screen. Flipfont is the same
as the Edmond font, except that letters are flipped.

Characteristics
— Same letter shapes as Edmond

— Different font sizes flip letters different ways

gdobstedifAlmaogpIZIUVWIYE
*[SERCATER0-=][".. N/

12 point

+shit AGOAIIVHIITAIMUWUOGOAST UVWXYS

SI@DHENF DY +F{" <]

10 point This is a sample of 10-point Flipfont,

12point T iz iz 5 2emqle ot I S-qoin?y Tliqion?,
14 point 111712 12 9 29whie 01 [¢-horwg ryrhiowg:

18 point 1 11¢ 1¢ e sewdp o [ g-doruy Jridjouy

losM s shieri baqge1t m*I ,qlsH

Dr. Jekyll
L' HAQS
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Using Flipfont

Which letters stay the same when you change between 10-
and 12-point Flipfont? Between 12- and 14-point?
Between 14- and 18-point?

Try typing the sentences at right just as they appear,
starting with what would normally be the final
punctuation mark. Before typing, change the font size to
12 point and the style to Align Right.

A palindrome is a word or sentence that is spelled the
same forward and backward. Try typing the palindromes
at right. What happens when you change between 10 and
12 point? Be sure to rest your brain after trying these.

amhidextrons

What goes up w2 COWe oM

(7]

FLIPFONT

T iz Yor? iz sll deodwes1bz,
112 017§ 12 9] PYCKMILOR!
L Y18 JOu] 1€ e[ qedimelp s’
This font is all backwards.

zh1ewioed [I6 2i 110t 2idT

.gob vz6l 5 19v0 agmu| xot awold Aoiup sdT
zavo? vrilz adt boas 2llitd zewT*

wadpw ot ool sldmig brs s1ve bid
2avogotod sdr a1aw vamim [LA

[awral

16090561

QTTO

TOO HOT TO HOOT
AGIIWAZIIATI 2AW IIFA

Four letters in
this senterice
are facing the

Wrong wavy.
Push me —wov [[r9
A A

- 8w O 8 A

S 8108 8 4 870 .

983 5 & O B3 O B Tt

238888888 8

ehrssood &8 8 8 8 &8 & & & 8 .2 Bookends
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Cﬂlose—up

Close-up ifu- i fnnft for l:n]alt{tingipay.?;:a‘ ;r;l; as ;t:,:]gt D[ 12 ot nj"‘ rtr 4 I d(h n
square portion of each letter is visible. Becau
each letter is missing, the overall effect is more of texture uJ Pdka 1L' "‘r L

than of text. “- = q a
w
1 L‘LEE L'l ﬂ ‘;‘

+ Shift =
AL

Characteristics
— Horizontal and vertical dimensions match Grid

— Square proportions
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CLOSE-UP

Using Close-up

Type your name. Try typing both with Shift and without ‘ | 4. FF
Shift. Try mixtures of both. Which is easier to read? i m

Keep Grid on to make it easy to select letters with the t .'uu n- 15' 4 1;

selection rectangle and to make it easy to reposition

letters.

Copy, flip. and rotate letters to make repeating patterns.

See how many different patterns you can make with the
same letters.

Substitute different letters into the same pattern and see

how the effect changes.

20
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“darts

Parts is a font for exploring the shapes that make up

letters. Each font size shows a different kind of letter part.

12 point all parts
14 point straight strokes
18 point curved strokes

As you change font size, different parts will appear or
disappear. For best effect, use Command-< to change to a
smaller font size, and Command-> to change to a larger
font size.

Characteristics

— Different font sizes show different parts of letters

24
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Playing with Parts on Paper

Which is easier to read, the upper half of a word or the
lower half? Cover up the upper and lower halves of the
words at right and see for yoursell.

Which of the letters at right has only straight parts? Only
curved parts? Only diagonal parts? What words can you
make using only one kind of part? Draw your own fonts
using only one kind of letter part, for instance, all straight
lines.

Print your name in capital letters, letting the pen or pencil
touch the paper only during straight strokes. Try it again
with only curved strokes.

Draw an A, leaving out as much as you can without the
letter becoming illegible. Do the same for the rest of the
alphabet. Write words in your minimal alphabet.

Draw a pattern of disconnected horizontal, vertical,
diagonal, and curved lines that looks like writing but isn't.
Graphic designers call this “greeking’.

=

FARTS

which half reads

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
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Blend

Blend is a font for creating puzzles. When you type, letters

pile up on top of each other in the same place instead of

appearing side by side. The cursor doesn't advance until 12 point
you type a space. Blend includes both positive (black on

white) and negative (white on black) letters.

Characteristics

— Letters pile up in the same place when you type + Shift

3
K
T
B
K
T

A\

— Upper case only

il <70

HE ==2m

— Spacebar advances cursor

— Shift reverses black and white

Using Blend
Pairs of letters create interesting puzzles. Can you see
which pairs of letters created each of the designs at right? $ x B " H

To solve such puzzles, you must visualize which letters
share which parts. Check your answers on page 40.

Negative letters make harder puzzles. Can you see which
pairs of letters created each of the designs at right?
Reversed letters act like holes cut in black cardboard. Only
the common white areas show through both layers.

Can you read the two five-letter words superimposed at

right? Hint: the two words have opposite meanings. You
might want to try typing your first name on top of your w H A m E

last name, or superimposing other pairs of words.

Positive and negative letters make yet another sort of
puzzle. To solve such puzzles, imagine which letter
contains all the white areas. Then imagine which letter
blocks the missing areas.

26



Making Designs with Blend

At the right are some pairs of letters typed in Blend. Can
you tell which of these letterforms were used to make each
of the designs below?

Blend can be used as a starting point for designing

monograms, logos, or symbols. Try playing with Blend and
see if you can design a monogram of your initials.

BLEND

27




Blo[x/e[s

Boxes is a font for typing cryptic messages. Each letter in
Boxes is reduced to a black box that is the height and
width of the letter.

Characteristics

— Letters have same heights and widths as Parts lelters

Using Boxes

The Boxes font was made by covering each letter in the
Parts font with a black rectangle. Type a message in
Boxes, then change the font to Parts. You will see the
boxes magically turn into letters.

Can you decipher the common sayings at right? Hint: look
for letters with distinctive shapes, such as i, t, and m. What
other letters have distinctive shapes? Check your answers
on page 40.

Here is a game to play with a friend. Choose a familiar
category, like names of local cities or people you both
know. Take turns typing words and letting the other
person try to read what was typed. For instance, the words
at right were typed by someone who chose font names as
the category.

28
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What Boxes Tells Us About Legibility

Both of the sentences at right say "All that glitters isn't
gold.” The first is typed in lower-case Boxes (with initial
capital) and the second in upper-case Boxes . The first
sentence is easier to read because the varying heights of
lower-case letters give words distinctive shapes. When we
read, we look for these shapes to help us identify words

quickly. That is why lower-case print is easier to read than
upper-case print,

BOXES
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|essellation

A tessellation is a pattern made of many copies of a single
shape that fit together like pieces of a jigsaw puzzle,
without any overlaps or holes. Every letter in the
Tessellation font can make a tessellation. Try stacking and
interlocking letters, and see what designs you can make.

Characteristics
— Lower case only
— Made entirely of squares one grid unit in size

— Every letter can make a tessellation

Using Tessellation

Tessellation is a great font for exercising the flips. Start
with any letter. Make a copy. Can you flip the copy and fit
the two letters together? Can you continue copying and
flipping to make a pattern that fills the screen without any
overlaps or holes? Use the paint bucket to fill letters with
textures and bring out different patterns.

See if you can discover how each letter in Tessellation
tessellates with itself. Some letters, like r, tessellate in
more than one way. You can also make tessellations that
use several letters, like n and c. Note: some letters, like o,
cross over themselves at corners.

For a harder challenge, try designing your own tessellating
letters. Use the line tool with Grid turned on to draw the
outlines, then use the paint bucket to fill the interiors. g el e DS o BE3 RS '
Can you invent upper-case letters that tessellate? R B s s s
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Escher

The Escher font was inspired by the intricate repeating
patterns of Dutch artist M.C. Escher. Some of Escher's
works use a font similar to Escher.

Characteristics
— Square proportions

— Horizontal and vertical Y "G _
dimensions match Grid IR, M S W T S

— Three font sizes

Using Escher

Many of the letters in Escher turn into other letters when
rotated or flipped. Such letters are called pivots. You can
use pivot letters to make words that intersect.

Think of Escher as a vocabulary of shapes to choose from
rather than a font to type in. If you type words without
choosing shapes carefully, you will often get uneven
results. Choose shapes that go together. At right are four
ways to make nut with Escher letters.

The highly symmetrical letters in Escher make excellent
raw materials for inversions. The inversions at right were

created by modifying letters in Escher. Can you figure out
how they have been modified?
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Making Patterns with Escher

Patterns are Escher's forte. Here are pinwheels based on
the words DREAM, RADIATE, and DANCE. These pinwheels
work because the letter D can pivot to become A. Any word
in which the same letter shape appears twice, once right
side up and once rotated 90°, can make a pinwheel.

Here is a special type of pattern based on the word
DREAM. Look closely and you will see the DREAM pinwheel
repeated in the DREAM pattern. A second kind of pinwheel
is based on E rotating to become M. Can you see it?

The DREAM pattern works because the D/A pinwheel and
E/M pinwheels spin in opposite directions: D rotates left
90° to become A, while E rotates right 90° to become M.
Almost any word that contains two different pairs of pivot
letters that turn in opposite directions can make a
pattern.

The one exception is that if the word has too many letters
beyond the last pivot letter (or before the first pivot letter),
it may run into itself. For instance, the word DREAMS
could still make a pattern, but DREAMER would run into
itself. Can you see how?

What other kinds of patterns can you make with Escher?

Wwo=d

DRE
=

DREAM OX
wo3dd DREAM
D Wo3dd DRE
m ol Wo3dd
DREAM 00 W
O3dd DREAM [
0 Wo3dd DREA
m 010 wo3dd
DREAM 40U WY
340 DREAM OU
Wwo3dd DREAM
anu wo3dd D
ReEAM 0 WY3
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aru wo3dd DR
eEAM 00U WO3d
d DREAM OO0
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infinity

Infinity is a font for making inversions. Each letter turns

LN
e e e e ABCDEfG AT 11
Nnopqrsivywx)z
*

can create inversions on many different words.

Characteristics

— Lower case only

o =« eaiaefbyilylia

— Horizontal spacing matches Grid 110 d bJ’S Ia /i MXx 1 o

Using Infinity

At right are some inversions you can type in Infinity. The

“ 5
first word reads the same upside down, while the others 61 S l d e'r 'I‘ e S’ 1’
become different words upside down. What other words
can you discover that work as inversions in Infinity? od ¢

Infinity has only lower-case letters. When you hold the

Shift key and type a letter, you get the same shape turned Su ns
upside down. For instance, Shift-N gives you a U. To type

SUNS, I typed S, Shift-N, N, S.

You can create custom letter shapes by combining parts of
letters. The best place to cut an Infinity letter apart is
halfway up. For instance, you can combine top halves of
the letters i, r, t, and | to create custom letters that read as
one letter one way and another letter upside down. See the
facing page for other custom letter shapes.
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If you want to make your own puzzles in MacPaint, the
Edmond font is for you. All instructions you see on the

screen in Letterforms & [llusion were typed in Edmond.

The instructions you see in this booklet were typed in a
font called Bookman. Note: there are no puzzles on the

disk for Edmond.

Characteristics
— Line spacing matches Grid

— Hold Option key for special characters

Using Edmond

Keep Grid turmned on when you type. Grid makes it easier
for you to position the cursor to retype a line, or to select a
line of text to be moved. All screens in Letterforms &
Illusion were typed with Grid on.

When you click to begin typing, you will notice that letters
appear slightly lower than where you might expect. This
adjustment was necessary to make letters fit entirely
between grid lines.

The 12-point version of Edmond includes special
characters such as left and right double quotation marks,
copyright sign, MacPaint tools, and flips icons. The
diagrams at right show where the special keys are located.
To type special characters, you will need to hold either the
Option key or both the Shift and Option keys as you type.
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Making Your Own Puzzles

We created the Letterforms puzzles using just MacPaint
and the Letterforms fonts. If you have your own paint
program you can make and save your own puzzles.

An easy way to create a new puzzle is to copy one of ours
and change it slightly. Can you make up your own letters

i

EDMOND

A good puzzle should have a clear goal (an example always
helps), allow a range of approaches, and have a definite
right answer. The reader should feel a satisfying sense of

completion when the puzzle is solved. Most importantly, a

to substitute into the puzzle below? How could you make

the puzzle easier or harder? What if you allowed more
than one flip? What if you used a smaller grid? What if
there were shades of gray in addition to black and white?
How else could you change the puzzle?

Use the middle of the screen for the
puzzle itself. Leave adequate white
space for the reader to work.
Anything you want the user to
select with the marquee should be
enclosed in a dotted rectangle
drawn with Grid turned on.

Keep instructions brief, MacPaint
tools may be mentioned either by
name or by icon. The first time a
tool is mentioned, use both the
name and icon, with the icon in
parentheses.

In the lower left comner, tell the user
where to find answers. Messages at
the bottom of the screen are typed
in 10-point Edmond.

Characters or words you type are
in quotation marks. References to
characters or words you see on the
screen are in italic (14-point
Edmond). Command names are in
bold (18-point Edmond).

.} Answers:page 41

ER=—=. L L AAY — — ——— ———

In each letter pair above, change the first letter to
match the second by flipping a block of squares. 1 H
For example, you can turn the © intoan A by 11
flipping the bottom three rows, as shown at right.

I
If a file contains more than one screen,
separate adjacent screens with a dotted
line the full width of the page. There is
just enough room vertically for three

screens per file.

puzzle should be fun. If it feels like a chore, it is a
problem, not a puzzle.

Be consistent about where you put different kinds of
information on the screen, so the reader always knows
where to look to find out what to do next. Below are some
style guidelines we followed.

Name your files alphabetically so the
Next File command in the Flips
menu will open them in the order
you intend. Next File opens files in
the order that they appear in the
Open File... dialog box.

You may want to use spaces and
numbers in labeling your files to
force files to appear in the order you
intend. For example, " Introduction”™
precedes “24 More Jigsaws”
precedes “The End".

~In the lower right corner, tell the
user what to do next: either “Scroll

up for more.” or “Type #N for next
file.” You may abbreviate words, but
do not use icons, since they look
like buttons to click on.
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Kits

EINSTEINSTENS
TEHNSTENSTEN
STEHNSTEHNSTH

NSTEINSTENST
EINSTENSTENS | 7 |
TEHNSTEINSTEN
STEHNSTEINSTH

NITEHNSTENST
EINSTEINSTENI

v=
1
=

&
o
=
=

PROBLEM
[ lTain| SOLUCLON

Each of the designs above is an inversion from the book Kits is a folder on the software disk. It contains puzzles
Inversions by Scott Kim. An inversion is a word that reads made from the designs on this and the following page.
in more than one way. It may read the same right side up Each puzzle gives you a portion of the design on the
and upside down. It may read the same in its mirror screen. Your challenge is to use the Flips DA and
image. Or it may exhibit some other striking form of dual MacPaint tools to recreate the design. For a greater
readability. challenge, close this booklet and try assembling the

designs in Kits without looking at the completed versions
on these pages.
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Can you identify the symmetry and structure of each
design? How does the image repeat itself? By recreating
the design in MacPaint you may get a closer view of the
visual trickery and magic in each image. You can then go
on to recreate this trickery in puzzles and designs of your
OWT.
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Answers

Page 26 in this booklet (Blend)
IS, AY, ED, HX, FH

IS, AY, ED, HX, FH

IS, AY, ED, HX, FH

BLACK / WHITE

Page 28 in this booklet (Boxes)
All that glitters isn't gold.

Many hands make light work.
Too many cooks spoil the broth.

[llusion Infinity Tessellation
Flipfont Edmond Close-up
Parts Escher Boxes Blend

10. Inversions

T a8

before OWINg ' back
- o e

* Flip Horizontal, Flip Vertical =
Flip Vertical, Flip Horizontal
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12. Rotate Lel.'l: Rjght
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* The following operations are equivalent:

S B
=
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CE-00-80 =6
(R-08:-80:-00 =&




14.

Halphabet (continued)

ABSDMF G

Puzzles that have more than one answer are marked with
an asterisk (*).

20. Zebra Examples

identical / opposite: Type the two words separately, select
the top half of identical with the marquee, and move it
onto the top of opposite.

fade: Type the word, select the bottom fourth with the
marquee, hold the Shift, Option and Command keys, drag
the selection down, select a white pattern, and use the
spray can to whiten the bottom of the word.

phase: Type the word, select the bottom fourth of the word
with the marquee, drag the selection right a little until
white stripes align with black stripes, and choose Invert
from the Edit menu,

22. Flipfont Typing

PHILIP — dHITId
CATHY — JVLHh
Williamm — Mljjlew

Anne — Vuua
Larry — TVJJh
Linda — jlupe
bud — qnp

24. Closeup Match

NN’

B
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27. Parts Straight, Curved

letterforms
remarkable

. pinstriped
minimum
lackadaisical
. bedecked

FeCpmR™S 0oQeOR

29. Blend Positive
V1, 0S, ZX, TL, YH, TH, MA, ZN, BK

30. Blend Negative
OX, DK, VI, NO, MW, TH, ZN, PJ, HI

31. Blend Mixed
X0, TA, XN, UH, FE, MV, BD, WI, GQ

42

Boxes Languages
Italian

French

English

German
Swahili
Chinese

~oapop 6

34. Boxes Sayings

A stitch in time saves nine.
All's well that ends well.
Beggars can't be choosers,
Silence is golden.

Seeing is believing.

Look before you leap.

me Q0 oTe

36. Tessellation Jams
mystery, monkey, fitting, interwoven

37. Tessellation Negative

soar wax
Zone cat
musician

read sank
what push



Puzzles that have more than one answer are marked with
an asterisk (*).

38-39. Tessellation Letters (in alphabetical order)

‘HL.... o
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38-39. Tessellation Letters (continued)
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41. Escher Crossword
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) -
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I ul
N >
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<
m
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W m m_ i
NIZ ZEN

Puzzles that have more than one answer are marked with
an asterisk (*).

44. Escher Patterns
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